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=R Windows XP {EER# Windows Vista {EE Rt Windows 7 fEZERIR

BRI Windows XP Service Pack 3 (2% Windows Vista (32 27T ) Windows 7 (32 iZ75H0
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Agilent T&M Toolkit Runtime £ Agilent Measurement Manager ¥RE8fE 2 T\ 2 5= 2 T\ FRRERT
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B. &% Agilent |0 Libraries Suite

4 ,'ﬂ]” # 10 Libraries Suite [V Agilent Automation-Ready
REOMW‘ PC iy CD-ROM A HEAS1 o 5 rﬁ;&*ﬂ,g’ ﬁl Z[L
fﬁﬁ' PR 7 -

10 Libraries Suite

* Access 1/0 tools through the 10 icon in your system tray
* Use Agilent Connection Expert to manage your instrument connections
° Use Interactive 10 for instrumant command dabunain

° Use Agilent 10 Monitog? LB B HEE lee!d

a7 Agilent 10 Libraries Suite 15.5 Setup is preparing the InstallShisld
b= ‘wizard, which will guide you through the program setup process.
Flease wait

Preparing to Install...

LI )

ypwgﬁj F IE*JH 15l E’lgﬁiﬁ ,‘%EJ@( )
e - "% Start > Run...

ol TR BEEREE > : autorun\auto.exe (H [[1 < BEERE > L
[&0 CD-ROM & FRESHY (B »

£—IE 10 Libraries Suite ZEZHIE [TBEZE

EE AR 10 Libraries Suite F7 » Hig{t zé?u%ﬁ&‘ﬁz Runtime iR 10
Libraries HYSIE - (€ 10 Libraries Suite 14.0 BHA » Er‘%ﬁjﬁﬁﬁ
@ﬁﬁ%t’]hﬁ?&%ﬁ% (IR B Runtlme LZHGEIF) o
FieR  RaEs— FEERFI0 lerarles Suite Eﬂﬁaﬁ?ﬁ?ﬁ?’sﬁmﬁ:
oJ; i%lu\ﬁa-ﬁ?"*ﬁaﬁﬂ I/0 ?E_Y MR BHREB LRI/ FER
K » 55&HY Custom) &8 ; HIE [Select Features | ¥1557T18 0T »
BEAEENSFMAE ﬁﬂh_\:

g

EH:

5 —L%fj;;‘ﬂﬁj TH ZHIEE > - % T Click here to install now | ¥
% 2 rﬁ rInstatllShleld Wizard | 13 -
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,umjuéﬁeﬁéfﬁﬁfimaﬁ S #&{EH 10 Libraries Suite 15 &7
 BENRENTHEESDE/BE -

6 [ (5f9 PC o 4 IVI £ 5] (£ IVI VISA COM f2v& 7
{4 > 10 Libraries Suite %ﬁ‘ﬁ o IF"H/ HER gl%ﬂ“ FF' o

IVI A TTHEFD VI VISA COM EETTHELETIERERNF - ~NE »
WRIMEZE VI TUHZEREENIE - :52E Agilent 10 Libraries
Suite {EEFSERRY TIVI LBTHMNBEEIZE] -

7 l, MnstallShield Wizard | ¢ .IE'Ef %E@ ™ Next> > Fﬂi[ﬁ%
7 10 Libraries Suite i #4 4 -

8 EJEET‘Y@F\ 7o YN [EEE AT IR S MESHER TT O accept
the terms of the license agreement N ]El UE FI}%L s JREE -
"Next > | &5 -

9 El, I—Ins‘callShield Wizard Setup Type | a:j‘ﬂkﬂ“hirFJ. EEIEJJ: (l'j[lq%ﬁ'
fra. ) 0 IV Typical FW Custom - Riid Next > o

Agilent |0 Libraries Suite 15.5 - InstallShield Wizard

Setup Type

Choose the setup type that best suits paur needs, lIo

Please select a setup type

() Typical
@ Recommended features for your configuration will be installed.

) Custom

Choose the program features you want ta install. Recommended for
advanced users.

[ < Back, ” Mext » I l Cancel ]
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"Typical —L%f%‘}ﬁﬁ;“ PR SR o BRI AR (2 PC Y
fevert il B o % T Typical | —Lgﬁgw s PP = PC =1 SEE (R
I VFSA gj?a HIl Agilent VISA b SEEL Vol VISA o YN
['*dPC R EE ]}’j@(ﬁﬂﬂj VISA i EE‘ H[l Agilent VISA ¢354
Eb = ol VISA (H% =i Agilent IO Libraries Suite i/ f“ [;’/
Hlpj PR S ] Agilent VISA ) e

- WNRIRIESZ [Mypical Installation ] » 553E— T Next > Al HEiEETT
TE13 0

« UNERIAESE [Custom Installation ] EIBIZHH » 551F— 1 Next > ifi
BIBET TERDE 10 -

10 [ (25248 T Custom | HEE + £ [5(19 PC 0 HEH okl
[ VISA (= IR G % RIERL ) UK Agilent
VISA b 5EEL fol VISA -

Agilent 10 Libraries Suite 15.5 - InstallShield Wizard
Install Agilent ¥154

Agilent ¥I54 will be installed as the primary Y154 and in side-by-side mode. If you plan on instaling
another company's YISA in the future, you may wish to clear the checkbox. For more information,
see the Agilent |0 Libraries Suite Connectivity Guide. [, agilent. com/find/connectivityguide]

Install Agilent VISA as primary YISA

[ « Back. ” Mext » I [ Cancel ]

PPN ST PRy Y VISA - K] 61 LK) F”ﬁﬁf L IE'
FLA% TV B T fﬁweij » e vgl% IIE}{—] Agilent VISA F 5t

%1 VISA -
1/[[3:1%—' RHp ﬂ El —a\E' sﬁv[ %‘#F}Ej Agilent IO Libraries Suite i/
}"L/%/H 1fi | @ H] Agilent VISA | -
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11 YN [ EEE‘? FCustom | FEE > fI[ ™~ ’4bfﬁﬂﬂjfp4%> CTENNS “lz
TFiff o
* IO Libraries Suite [ IfuByevf]
* Agilent VISA [ IfURyeyf] 7k
o IVI 7 [ | Ifosss
VISA #HIIVI | [ﬁ*&n“ \fr & o jﬁm fft b FLFIHE' T sy
S o g,hﬂ—ré\_ﬁl’ N l|7f*ErF{HlAg@lentIOLszames
Suite ﬁ_’gfﬁ/‘;f/ VglﬁqL};ffIVI HHER[F ]EIJﬁ‘] EF .
12 P (22 rCus‘comJ P Gk TibL T Select Features |
a:j‘ﬁﬂijiﬂ‘ o
i OBV R ogE o AR g PRSI e AR
FJ“%F”—L“F tFats o gl L T IJTE,II [£'] 10 Libraries Suite 9%k
R E{Jﬁm VR P 1 T
')“L[’[F'EJ[ T
i SHEIVERRID D é‘< Fiz)rf t,]a URIVHBL o FEIREIRPS D ﬁfg[
‘)JH F[JWTTV—‘U{:FLO = ?VﬁJ cFAY g > - T Next> o
13 T Start Copying Files | a:Jf *JiFaLElrf“ s #— 7 Install ff JKIF
IR -

Agilent 10 Libraries Suite 15.5 - InstallShield Wizard

Start Copying Files

Rewview settings before copying files. IIO:

Setup has enough information to start copying the program files. [F you want bo review or
change any settings. click Back. If you are satisfied with the settings, click Next to begin
copying files.

Current Settings:

Microsoft Visual C++ 2005 Redistributable 86 A
I/ Shared Components
41 Y154 Shared Components
10 Libraries Suite: Directories:
Core Praduct Directany: C:4Program Files\Agilent\D Libraries Suiteh
'] Components Directory: C:%Program FileshlYl Foundation'V1
WS4 Directory: C:\Program Files\Yl FoundationtW154

Selected Features:
Agilent WISA as primary

[ < Back “ Install I[ Cancsl ]

U PC Vi 5 Microsoft NET Framework 2.0 W%
IO Libraries Suite }{ﬁ’%’?%%{ﬁﬂf’g¢ s AR 2 i %l—{ Sy E o
Microsoft .NET Framework £% IO Libraries Sulte BRI
o NET AEZCSBEE T SIAIE 20 Pyl s R u%l gl e
75#‘1%“ Bl [;%‘;[{% % EIFrb5E > JYRLF] 5 10 Libraries Suite -
F’]K ,\§=F;I—L k- v NET Framework °
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it iEJF“EJ&L §E1/0 U "ﬁtﬁﬂﬁfﬁi YN [o5
? 7 el ELFTRIAS E]J’AE ujﬁhﬁ Connection Expert [/F'Jf:[
;g?fﬁj 7
15 Hi " InstallShield Wizard Completed | amfﬁﬁ“uiﬂ FEJE\JT » e
O Libraries Suite =574 -

i - "~ Finish F%I%FJ{ IHEJFLI
i - N EH- 4@%/5@4\@4{@ it JVIHE 9 Agilent i
ﬁﬁjiﬁm@*

16 £ 7 T " Windows S W1 1O F IR (K
Al *Fh= 10 Libraries Suite °

17 i/[[%J [&JoH [ 1O Libraries Suite — |ﬁ%& BEEPRE - TP
i iF (Bl Agilent VEE) - HIF 1 b3 3% AHE o
CD (REgvAEz" ~ B ET) o Jp (R S
* S CD Jﬁ PC _-fiy CD-ROM A #3445 -

* [ CD [ | LRI PR BN Pty 2

18;'1—J &5 fl H SRR 2 H lﬁfﬁﬁkﬂJr [T’ USB [ﬂ%’é?& E8491 IEEE-1394
FireWire E1#fiig = VXI /7 o1 - ig@zrm |FR -

19 J[1H\ Connection Expert =!7t#h~ v%}iw ~ Refresh All $$11 %
R SE RS PR Y (PRI -

20 {[If! Connection Expert &4 £ » 5h0 'Hﬁihﬂ fifb Y 1/0
A 1 7t T Windows Notification ; [t 5 [ 1 > 10 [ﬁ[ﬂ
(@) SRy~ ™ Agilent Connection Expert -

i rExplorerJ ﬁ’i{ﬁ‘ﬁia‘éﬁfb O/ EAIGRAS o F— T A
S 175 CHI A ) U
[ﬂ fr?:;;lﬂ IIEJ[,’%F‘FII YO T RS B A VAR e T T
o '[J%"P‘?Ef '—VerlfledJ AR > 0 5T R 2B o
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i TERIRED FIF R J%‘;ﬂi[fi,[#‘ flif#~ "~ Change Properties...,
R IE I%I/O CRE (g 3=§,[

AERMITEE A Agilent 488 API 5251 GPIB {#&2S » S\ 2% 18 Agilent 77
ETFEEE (BIY0 GPIB £ ) #1TEE NI-488.2 fHERVIET » BITJRESS
2 Agilent 488 12T\ EE - 5 XN 551Z— T Tools > Agilent 488...
SR EFUESEA [Enable Agilent GPIB cards for 488 programs | AYZEN
T318 -

TR M e R EPHIEG E%“fi?vru PR > i IR

*F[%jfﬂj%j Send Commands To This Instrument -

WREZ5E 10 Libraries Suite FFE54-RI78 - 5522F Agilent 10 Libraries
Suite iEIZISETRY [ Z55REPERR ) —8N -

{=H UAC RY Vista Z28¢

WNR7E{FE A Windows Vista {E3E ARV R =25 10 Libraries Smte
FFES £ RIRE » JeE_RRREBR T [fERERPIES (UAC) -
MEWRERAR - KRB iRBEE - 225< 10 Libraries Suite ZEU
IVBSEISFE UAC »

OB R e > R R [PPSR Agilent 1O Libraries Suite ©
IHﬁ qf}[ﬁgﬁ%ﬂln Elﬂ:[[ﬁﬁ\ TSR T 'fjtﬁ" ﬁﬁ‘_jf‘tﬁ[ pjjﬁ ﬂ[[ﬁ
10 Libraries Suite IZEFIEYF » ﬁ%lﬂf'
www.agilent.com/find/iosuite -
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C. ZREEREENTETN

- FBAEEEENER PC B USB BHATNERIERR - BLERE
hﬁ

- EESTEEINEZEE 10 Libraries Suite 15.5 WS B HThR A » A4 il
’faﬁm‘FﬁUiﬁ%ﬁk ZZD 10 Libraries Suite ZHRZFAVGEAET - 5
SR 16 5AY [B. Z8E Agilent 10 Libraries Suite ] °

1 FE§JLEJPC ﬁ]% TR ( 23| 4E|pJ TA. ﬁ@\,
[& E'LJ—?F TJ PC “EF T r‘%” ? ’L"E@J;‘H Agilent
USB “”*LF; ]ﬂi - j:@ﬁ Jg# DVD ROM -

2 J Agilent USB e é ﬂﬁp—rﬁa@g % DVD-ROM £ * PC
v DVD-ROM 7{.{1#H djié““*j/q ﬁl EE l‘ﬁﬁhﬁﬁ,ﬂ%{,[
e E EIFIEA = 'jﬁﬁbﬁﬁjﬁil ’
e J— "~ Start > Run...
o G < MHRES > \\Autorun.exe > H 1 < AHGES > RLIEEY
DVD-ROM ﬂﬁﬁﬁkﬂﬁr\% °
3 i%’ifﬁféﬁﬁlrﬁﬂfﬁﬁ » #¥— 7% THardware Driver | 3 » ki
riﬁ [ InstallShield Wizard | /3 -

Agilent Modular Products E“E‘El

Agilent Modular Products Installation Menu

Hardware Driver Click to install the hardware driver of U2781A,
I3 I=f / 1
\Veasuremant Mana U2300A/ U2500A/ U2600A Series.
Software Driver Far all other models of the modular praducts that are
notlisted above, the hardware driver is embedded in
Sample Codes the Measurement Manager installer.
Documentation

Explare Folder

Exit

© Copyright Agilent Technologies, Inc.2006 - 2009
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4 i l, " InstallShield Wizard | HEELIEHJf %“Hy ™ Next> > FEJi[F"[ij/
VFI‘E@EJJ%E L °

5 BHFEHENE AAY - YN EE O IR S NSRS T accept
the terms of the license agreement N ]El UE Flﬁfﬁ s Rt T
Next > 7&5& o

6 ~n‘E'ELJ§E Readme &¥5 » Fr’:"-tb [£-PC 345 USB B =" %
P‘##;;f o '~ " Next > &= -

7 E [ InstallShield Wizard Setup Type | tﬂ‘ﬁfﬁﬁﬂe ELEJJ; (o1 ﬁ?ﬁ'
f=-) > 3E 3V Typical FY Custom - IRt Next > o

& Agilent U2781A,U2300A/U2500A/UZ2600A Series Driver V1.04 - Install... E|

Setup Type 1 J I
Choose the setup type that best suits your needs. =
Please select a setup bype,
©iypical
All pragram Features will be installed. (Requires the most disk
space.)
() Custom

Choose which program Features you want installed and where they
will be installed. Recommended for advanced users,

[ < Back ” Mext = 1 [ Cancel ]

"Typical | i%&;‘)ﬁ SR P (S P TS A A [ PO i
fEnvs g

- WRITIESZ [Mypical Installation | » FEIZ— T Next WH&IEETH
oo

o UNERMIGEIZE [Custom Installation ) EIEIZER » 53 Z— T Next il
BIBET TERDES -

8 YU [EER T Custom | P > 1‘]’ %15L T Custom Setup
a;-‘[‘_lz"l‘fji-F.L o

i N CTeN a0 R P e L I R G i

%F” Ny I fr &= fi

ii T "This feature will not be available | 32’ - JE[= 1
EIXFIJ’F,FI“JJFJ‘: o ;:jg?vjjﬂtgh»;&}fgg s fF—~ "~ Next> -

Agilent USB & TV E mAIRMIREAPIER



Agilent USB 1&#A TV E RBAR#M

& Agilent U2781A,U2300A/U2500A/UZ2600A Series Driver V1.04 - Install... E|

Custom Setup \ A ‘

Select the program features you want installed,

iZlick on an icon in the lisk below to change how a feature is installed.

Feature Description
DAG UZ3004 series driver.

This feature requires 348KE on
wour hard drive.

Install ko

CAWINDOWSisystem32idrivers)

[ Help ] [ Space ] [ < Back “ Mext > 1 [ Cancel ]

9 "Ready to Install the Program | %ﬁ%*}ﬁ&]ﬁﬁfmﬂ T H—
Install F'ﬁj?ﬁ?ﬁ@ﬁ?iﬁ o

10 Hi " InstallShield Wizard Completed ; S5 HFLTH - A f8h
né'ﬁﬁﬁﬁ?“”"ﬁﬂ]%%fﬁgj ’ ﬁ%ﬁ" “» Finish %%%WFJET °
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D. Z2%% Agilent Measurement Manager

26

BEAEEREEZE IO Libraries Suite 15.5 IREXEFHTARA » 7 .d&“ﬁ’f@’ﬁ%
ET?T@J@%’R £ 10 Libraries Suite ZE2FRVEEME 5 BSE
F16E/Y B. % Hﬁ“i 2% Agilent 10 Libraries Suite ] °

T PRSI AT 23 FIfY TC A SERRETES | B AR
A5k s 5 Agilent Modular Products Installation Menu {75 £ B
FE}I{F“ ’ IUF[ FERE R4 7\ K %&ﬂgﬂ%ﬁﬁhﬁ_‘\ Hoo

2 FEFRSPY PC R e [R5 ?(ﬁ PEEY 14 FIEY TAL K
F[J’li"ﬁtj ° ;% PC FF” FEPY N R YE T Agilent
USB #i'=¢ 1A x%‘f DVD ROM -

3 i Agilent USB f;i’”"‘é ok b 2% DVD-ROM £5* PC
Epu DVD-ROM & 74 /ﬁrﬁé‘éﬂ%‘#@l E[LSLE g wjﬁﬁl Fj“' °

IR I RE TEER
e J— "~ Start > Run...
o @t < IR >: \Autorun.exe » H [ < WABREE > RLIpY
DVD-ROM & A (R o
4 iéﬁé?s‘i *JffJFJVTH SHEE > 4%~ 7% T Measurement Manager | % > IR
EEES iﬁ I InstallShield Wizard ; &3 -

Agilent Modular Products

Agilent Modular Products Installation Menu
Hardware Driver Click to install Agilsnt Measurement Manager
Measurernent Manager application software
Software Driver This application software provides the following
capabilities:
Sarnple Codes - Hardware Configuration
Docurnentation - Waveform _DIBD\EV
- Data Logging
Explore Folder - Self-Calibration
- Self-Test
- Data File Manager
- Convert Binary File
- Command Logger
- Signal Conditioning
Exit
Copyright Agilent Technologies, Inc.2006 - 2009
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{iE PC BIBRATERMTNER » BIEEET -

5 [ ERE AL fé/“\ffﬁjﬁf&"ﬁ% » [InstallShield Wizard Software
Prerequisite | %ﬁ%ﬂjﬁifﬁlﬁé e H- N 0K s F'ﬂi[ﬁ‘&’%fﬁ’?ﬁﬂj/
U

(ML 1 T BT D - 7 i

Ry s Tﬁ”l%ﬁig%@é = ﬂéﬁfj’ﬁ@ Measurement Manager fi #4’
g

6 i InstallShield Wizard | H‘,EEJE\JJ? , ﬁ%ﬁi@'— ™ Next> > F'#Ji!fﬁ/

£ Measurement Manager °

1 BHF F’*‘ﬁé o YN [EFE AT R - %HF MESIEL TT O accept
the terms of the license agreement | fUEFifF e > R
M'Next > | &5 -

8 IHH I Customer Information Form ;| » Jk&3F— ™ Next -

9 }— ™ Next ﬁﬁﬁﬁ\?ﬁ'i%&fﬁ-@_p%?ﬁe[ﬁ< » f¥k—~ " Change
A= Ry S

10 " Ready to Install the Program ‘éﬁffﬁ’ﬁﬂ’fﬂﬁ?ﬁlﬂmfﬁ -
Install F'ﬁji[ﬁ?ﬁ?ﬂ%‘!ﬁ?i °

11 Fl, MInstallShield Wizard Completed ; 5f=5HIp L > A fgh
nEE@Eﬁ@?UL”"E*]HJ%fE\Jf ’ %E‘/‘ * Finish Eféﬁﬂﬁﬁffi“f o LR
}{ij’ﬁ&;ﬁﬁlfﬁj BRI -

\

REERIER

{ERFEERERNNERERERR - MR TRE L MAYPTERR
o BEHEIEARFREBAREBELIER - LUEBE2ERRM - UIRZ
REER SRR ERPNERTHAEZER » RIIBILHG
BEARERNTREMER - LIBSEEEEMN -
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E. i51&E4EE 1 E PC

- FENIEECELEE Measurement Manager » BB EIT TP -
Qﬂﬁ-ﬁ Measurement Manager Z3< 2B RVGHEEF  :B2RE 26 B
BY TD. 225 Agilent Measurement Manager] °

+ TEEHRSS £ PC CRRTRIINEIRERIBA PC BIFEARMAD
EREENERBEMBNAE -

1 a‘aﬁ‘w}%ﬁf”f‘ ﬁf«‘ﬁg [EREAEA D ﬁj’ ‘*J,q&gij% %] AC/DC
ERUATIEES oAC/DC ?ﬁﬂflﬁfg;ﬁJLF 3: £% 100 = 240 VAC~
0/60 Hz - il EE +12 VDC -

2 3 AC/DC [HIFFHE BAf9 DO it R 4 At

Eﬁu%ﬂﬂ% o e

3 @F' [y USB At » }H USB fii-' = \F}ﬁ,ﬁ}%TUL PC _Fpyi=
if? USB sif it -

4 [V PC @ FIEn ARl VAR > 2 2 @il T Found New
Hardware Wizard i @ - TV rYes this time only | ZfifF
fi‘ ‘H{Vyﬁ X ’—NeXtJ 1&%]%&1" °

b TV TInstall the software automatically (Recommended) | » &
%~ " Next o

6 7+ Hardware Installation | ;fﬁ[fi,[HIrF'?H 'rzﬁ[%fﬁ EL e
@H nE'EJ%'%TF, » IRiHF— "~ Continue Anyway <5587 AL ¢

Hardware Installation

[} The software you are installing for this hardware
LY
Agilert USB Test and Measurement Device

has not passed Windows Logo testing to verfy its compatibility
with Windows XF. (Tell me why this testing is important

Corllrl.lng your installation of lhs software may impair

the comect 1 of your system
HIh\! immediately or in the future. Microscft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Anyway ] [ STOP Installation
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NREARLELRNZBEDNBSAR - SBIIR T IERET -
1 BERRE> EHE AW T REETR -

2 SEIEEREE > ARAE THEIHEN ERCE—TEHENSE
E - [LIFEHIR [ Driver Signing Options | ¥155733% ©

3 SEEY Tlgnore] EIEIZER » BIOEEESIAR °

7 E;E " Found New Hardware Wizard Completed | £f55 42 »
AR VRS i Rish PR
8 [ Assign USB device aliasJ EFJF{,[I:A HOZEL o B3R Jﬁ “”“W__%Ff[![
- [l*q ’Uim“jﬁg‘ Ml e f/[”ﬁy\‘ Fol {1 glﬁi}‘}'ﬂjfﬁ >
"Show thls dialog ; "5 XV T Never show this dlalogJq
'F‘ /\H{I%LH - FOKJ °

sgg

I=

Assign USB device alias El

Alias name: | UsbDevice 1

Identification: | Agilent Technologies Data Acquisition

Visa Resource Name:

Preferred | UsbDevice 1

Alternate |USBD::2391::5400::““146393037::0::IN5I'R

SICL Address String:

Preferred | UsbDevice1

Alternate |usz[Z}Bl::5400::““146393037::0]

Show this dialog
™ Each time a USB device is plugged in.
™ When a new USB device is plugged in.

(¥ Never show this dialog
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9 &HEF U2B00A 5%  U2500A 5%]] ~ U2600A +%[1#[1 U2781A I
9 ot ;;ﬁ%ﬁ&u S o an,’q@?ﬂ%j: Wﬂﬁl o
i PR @Jﬁ%\?iﬁ’ PC S AR - BT g ™ e
(CREE 2 S U (P EEEal: 3T
i IR S 1% PC Y AEI9AS ] f =N
Bt lﬁ%ﬁﬁf = PC F” GETE F Wd I OB
ﬂliﬂ?ﬂﬁﬁi = I F’?‘j H

Agilent U2722A Firmware Download

A different Firmware version has been detected, Would you like to replace
\"'/ the device firmware version ¥1.00 with version ¥1.017

i "~ ™ Yes ;‘IF[T ES@J?E’ PPN BEULR e |H'rr
r;t"\ o [#%\Ig_%f# PC [J T IJE5 ?J‘E-»I—‘LJIHHI%E“‘ F”F%’F
T u E F’?T l’

Agilent U2722A Firmware Download

Firmware download is in progress, please do not remove the USB or power
ion until the d load has

TESCRNENRE N &L AT » ANEINBR USB FBIREHR - FRETE]RE N &
EFTREEEKREHER -

10 - FISE BB AR AR (5 “”*LF}FF# [Nt |IE|F' o
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TEEHSE 71 PC_EBRTMNS TERIE PC RIFERGALE
15119 USB 14T\ E R R TR -

Connection Expert fL IO Libraries Suite fiv— it 5[F =0 -
Connection Expert [i' [ilfef = URIEF Y BGHEY - 7 b FpR PR o =
gagl‘ﬁ[’ﬁﬁ[[f:fﬁjﬁ“ PC Hlpﬂﬁiﬁf’ﬂ%ﬁ °

1
2

¥, PO 14 AEIOMEAT 2 7 L 5 3 R

Pl Connection Expert =7 i/~ ’ﬁ%ﬁ% ~ Refresh All 51} [%
LR P Y (R

J[IH! Connection Expert &%+ $h= » Zh EJHﬁLFI‘JF'E’Fg’Jf:F'U
I/O i fiz - % " Windows Notification | Eﬁ&iﬂf[l »H— N 10 q‘?ﬁ'
BR ([:) Ry~ ™ Agilent Connection Expert -

Agilent Connection Expert

Ltilities 4
Agilent WISA Oplions 3
Drocurmentation 3
Help Topics 4

Exit: Agilent 12 Control

About Agilent IO Conkrol

RS T u‘“&Hc C it (#7245 " Explorer | i 1)
[y Instrument I/O FIE b ok IEE%H%"’
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Wostiten e

9 et s

o

5 (ERHIZIFOBLE 2 % ]f][E[}[ﬁj’ 7 " Explorer | rﬁ%ﬁﬁlﬂ Instrument I0
B

Hi (&% TExplorer | ?J,,fr&Hh“try;[ﬂjﬁ ’flfﬁz' el [JF[LJ
" Properties | Fi/[’F‘H'?TE'IaaL sl [ f/['@ LG
VISA 3+ GPIB! i+ 5102 PRSI S

Refresh Al

= % CHDT 1227 O An identification query was done
S comi (ASRL1)
S COM3 (ASRLE)

L an (TPIPO) WISA alias U3EInstrument]
B UsB/GPIE (GPIBO)
= ﬁ USED IDN string: Agilent Technologies,UZ2355A, TW47222003,A.2008.11.04
57! Manufacturer Agilent Technologies
USBInstrument Model code: 23554
Serial number TW47222003
Firmware: AZ008.11.04
WISA address: USED:0x0957 0% 1318 TWw47 222003 0:INSTR
SICL address: ushO[2391::48688:TW47222003::0]
Address check: Mo
Auta-identity: Tes
USE driver vendar: Agilent Technologies

- S Ee
!’ :
b [

PPURHORAC Y SIS R fr A
(*IDN) 5 -
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6 = [FEJ}-{"’IEI“J Interactive 10 ;3 EJ] o E‘”]&l J;E_,wio Interactive
IOﬂp’Q OB F,* (a7 Fb[ e e S I
e R

¥}/ Connection Expert [JE?‘*J Interactive 10 » ofi [
Connectlon Expert “‘iJ'ﬁ SR Tools > Interactive 10 > 7Y &L
Tk ExplorerJ%i;ﬁr*‘ flir) i?&ﬂ%ﬁ G i o T F“ﬁ

ﬁ:%[ﬁ;ﬁﬂﬁl e i 7V Send Commands To This Instrument -

Refresh This Instrument
Change Properties
Ignoare

Delete

Add VISA Alias

Change Label

Send Commands To This Inskrument

7 rInteractlve IOJ S HL e 7~ 7 Send & Read >
Ei= *IDN? 3] I% > 7+ ! Instrument Session History pl

el rFA ;;f [HHE@«

K& Agilent Interactive 10 - CONNECTED TO USBO::2391::540... (2 |[B][X]
Connect Interact Help

o

Device Clear Read STB SYST.ERR?  Clear History ~ Options

Command v‘ Commands »

[Send Command ] [Read Raspnnse] [ Send & Read ]

Instrument Session History:

* Connected to: USB0::2391::5400::TW46393037::0::INSTR
-> +IDN?
<- Agilent Technologies,U23312, TH46393037,A 2006.10.10

|

8 [N Connection Expert fj= %" FIF{[% [LURLE 2 % Fﬁ#;i%lqiﬁ]?*’
fipe S TR AL o
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G. =& Agilent Measurement Manager

G. ZXE)) Agilent Measurement Manager

10 Control E7LINEEE) PC FESEE

EEE) Measurement Manager B 5RE11T 10 Control » {SEEEE
E{F{AEREZE PC AY USB {2HETNERIET B - & ZEH\1T 10 Control»
SEFSZERIIA > 2IVEE > 10 Libraries Suite > Utilities > 10 Control ©

TEEHRSS £ PC CEETRINETIEERIEE PC AVFRRMAE
2 B RENERERMBEMAE -

1§77 |l HiY Measurement Manager ’p’f{’ﬁﬁ‘ 4.5 5722 Start >
AII Programs > Agilent > Modular Products > Agilent Measurement
Manager > ['] ?féﬁgﬁ'«ﬁﬁ'

2 Measurement Manager ¥ [|# " l}{?]’ FT LR e

Agilent
Measurement Manager

www ngilant com! findd AMM

.5 Agilent Technologies
: > Allent Technologias 2006 - 2000

3 IF‘*ETP'I 17 Select USB DeV1ceJ am Ji‘FJ( %\E—T UL ot

fifi < TR A EHEH EFUE T 0K

3t 1&5\ b = PC ]EU ¢ T Available USB
Devices | E{IIF‘ FlIEE ERAA Jy*f“l F"ﬂ [f[
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4 Measurement Manager }L-{ﬁ]’?[ﬁ%k%?VEJ USB ;r':u;} r‘ﬁﬁ i
PR 8 AR« {15 [ (MR 5 7 g e PR PO
Tt o %#F}J Agilent Measurement Manager Help lee o
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UsB =TI\ EmETE

36

Agilent U2781A USB)FEL; 'A@ ,fg&wpip PR - J sy

A [l USB LAt =4 = 1 USB ngﬁ JHF' HE ‘7
USBTMC USB488.2 ?I@ [HI’L‘F = Measurement Manager%
[REE AT -

e A U278 LA R0 SRRl B B3 R ey P 50 7 e ™ [l
%rgu,il fUf= ] o F RI i Eﬁ U2781A AR 27evh| » ﬁ%if <
Agilent U2781A USB PR RS '/;»’{f;,t?/;’/

3 EREE| PCHY U2781A 1458

L BHHIE (PSR b 1 g ?‘iﬁF‘FHjL RIS A
uffi{ EEE] U2781A ESFEHY ] BO A
1 P50 L B (R0 gt -
2 [EEERS ATV -
@H JF%%[J?T{ FEESAEST K L BHES [ E AR
HE T URTBIA BT i 55 SERIRSETAS B e hoAss
J‘Lfg‘ﬁ T@[@?Pﬁw pﬁ* %é«tﬁj:ﬁ 37 gan 55 Jﬁ?n”“fr’ﬂ%
EF‘%W% ’
B 47 ML SAE L TIHIENE (R PO - IO AL A

[1] 2E2 Microsoft Windows {FERFEE
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65 fTM SR ZERIBMIER E

Hi [EPOmAT R LS U2781A}[§"<‘§7":§TE\ s ORI | B5- ST AP - 3
%ﬂ%lfllpfﬁsm}@%%ﬂ%ij f I i

GND GND GND GND GND GND GND GND GND GND GND F
NC NC NC NC NC NC NC NC VBUS GND USB_D- E
GND TRIG3 GND TRIG2 GND TRIG1 GND TRIGO GND GND USB_D+ D
TRIG4 GND TRIGS GND TRIG6 GND TRIG7 GND +12V +12V GND c
nBPUB CLK10M GND STAR_TRIG GA2 GA1 GAO NC +12V +12V +12V B
NC NC NC NC NC NC NC NC +12V +12V +12V A
1 10 9 8 7 6 5 4 3 2 1
4 55 iERIERIEEIRERIRE
Z®1  SSIEEEEMBRIEIL

SSI EFFHERE e

GND Eih

NC Rz

VBUS USB EE Rt BFEE TR RIER A

USB_D+ ~ USB_D- USB =¥t

TRIGO ~ TRIG7 fEEsEE Mk

+12V +12VEIR - B4AE)

nBPUB USB EREEA S8

CLK10M 10 MHz BFAR 3R

STAR_TRIG E0ER

GAO ~ GAT ~ GA2 IR TELIE R
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H &

LIS ETESAN

SEF A VI-cOM Ba@E)f2 X F1 MATLAB DAQ Adaptor HI#KES T
FIERIEXAE Agilent USB ##H 202 i L7 8 12 m 25% DVD-ROM
gt o

IVI-cOM B Ef 2 20 m] B 2k 3% &1 IVI-COM ER 553 o i I 5 35 2% »
MATLAB DAQ Adaptor HI| 703 7F MathWorks ER¥5E A42ei& BHH
HREAE 2 T (U2300A 251 ~ U2500A FZ511F U2600A %51 ) ©

ZEE vI-coM BEENFETN

1F Agilent Modular Products Installation Menu I % HY Software
Driver > IVI-COM » SR1238 I B2 48 2 % 7 it R TR U T B - VB BR
FAHNE 2 BRI B -

Agilent IVI-COM Driver =3

Agilent IVI-COM Driver Installation Menu

. ~
W U2300A Series This option is to install product's IVI-COM driver that is
W U2500A Series used for programming test instruments.

W U2600A Series
W U2800A Series
| 127004 Series
W Check All

v

Install
Back

© Copyright Agilent Technologies. Inc.2006 - 2009

5  Agilent IVI-COM Driver Installation Menu

VI £RTHERUEBAZE IVI-COM BREMENC RIZ S £ T3
IVI #BUG =R IVI HERETTH + www.ivifoundation.org o

- BEEE - g TIEIS N IVI-CoM SRENFE :

www.agilent.com/find/ivi-com o

38 Agilent USB & T\ E R ARMRIREAPIIER
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275 MATLAB DAQ Adaptor

7 Agilent Modular Products Installation Menu 3 ¥V Software
Driver > MATLAB > §Ri%3E “‘VE,@%&J/F{[ PF#I‘I' JIFIEG IV I o ERR
FAHIEY 3% gh = OR 20 i

5 Agilent MATLAB DAQ Adaptor,

Agilent MATLAB DAQ Adaptor Installation Menu
e UZ300A Series This option is to install Agilent MATLAB DAQ Adaptor
v U2500A Series to control products in Math\Works environment.
v U2600A Series Prerequisite
Please install Agilent 10 Libraries Suite 14 2 and

e Check Al IVI-COM Driver before proceed

Install

Back

@ Copyright Agilent Technologies. Inc.2006 - 2009

6  Agilent MATLAB DAQ Adaptor Installation Menu

7RIEHEC MATLAB (£ ELRE » INFTEZL S MATLAB [ Agilent #UEE
TUHEEATET  EE DAQBHETNER » 1 BZRZBEFTERIIE
I\ o U2 MATLAB &G
www.agilent.com/find/matlab_u2300a & U2300A 25! DAQ

www.agilent.com/find/matlab_u2500a & U2500A 25! DAQ
WWW. agilent com/find/matlab_u2600a 3&F3 U2600A &35! DIO

« YIEEUN{aIZZEE MATLAB DAQ Adaptor HVEHIIE R » SESERER

RIAY Usmg the USB Multifunction Data Acquisition Devices with
MATLAB Software Quick Start Guides °

. ,UTL,{E}%E MATLAB Z28% DVD-ROM EX/E1(t MathWorks #8ihZ
& MATLAB EXEE QD%EE}Eﬁ MATLAB Z% MATLAB Y Data
Acqwsmon Toolbox EXEE » LU NIINIEES AR ¢

www.mathworks.com/agilent/daq/tryit.html
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EEBIFENES

}ifl Agilent VEE - LabVIEW #! Microsoft (C# - C++~VB7 #{ VB6)
B IV o 1R AR S 0 i -

BRSBTS
b

7 Agilent Modular Products Installation Menu 37

Codes - ’Zﬁlapﬁl'jf@“]ﬂ%@ﬂ%ﬁnf[fltF@r[J P U e e

IV Sample

Agilent Modular Products

Agilent Modular Products Installation Menu
Harduware Driver Sample codes are provided for IVI-COM basic features
Measurement Mana and usages.
Software Driver List of supported products:
- U2300A Series
Sample Codes - U2500A Series
; - U2600A Series
_Aglent VEE | | o A2 T00A
LabVIEW - U2722AU2723A
-U2741A
Microsoft - U2751A
-U2761A
Documentation _U2802A
Explore Folder
Exit
© Copyright Agilent Technologies, Inc.2006 - 2009
7 EREHIIEINS

REEm e L

40

Measurement Manager Hf [ = fiyHTf IJF%JL{-D}ZL ﬁruﬁtjf i
T ETTEQ,|L|#E*\F%¢J( ”E»:,l-_ W |‘p &) |ﬁ| | A
Command Logger *jj EO= %&%iﬁj QJ 3?‘7:,41‘*5}{:7 N ISR
Agilent VEE -~ Mlcrosoft {hsual Basic ~ Mlcrosoft Visual C# F{‘/

Microsoft Visual C++ A=4 ’FE A= A -

jE'[FZ/[E?E*J Command Logger “Jf- ’ﬁ?‘?ﬁ‘?ﬁ Measurement Manager
¥ #2% Tools > Command Logger... -
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# Agilent Measurement Manager

File  Edit Wiew | Tools | Help

Fol=N . A @ Select Device. ..
-

Cammand Lagger...

License Panel

B Command Logger =

Eile.  Contral
oStart o HSave 13 Clear Display

Filter Options: |Na Filter b

Remarks

Date Time Device Type ' Command

Check all Uncheck Al

[[F; ft'%‘*ﬁ”f'l H T E Y Difr[f: : ?ﬁl q'%ﬁ%ﬁ'ﬁ’il FlT> -

"~ File > Convert Command File

Convert Command E]@

Select software language:

® Agilent VEE 8.5 and above

O Miciosoft Visual Basic 2005
Microzaft Visual C# 2005
Microzaft Visual C++ 2005

1] ] [ Lancel

Agilent USB & TN E B AIRMIREAFIER

M



Agilent USB E#E T\ E R AR

42

EAEHER

AR Command Logger FEFREINRVEHHBEF 552 Agilent

Measurement Manager Help File °

BRE

PP [ ulgg,rF i E’Egﬁaljj}l [ USB 8153 ':k%ﬁ [ F[FFW}J%EB'
PAtl > el f‘[T PR e [EETA ﬁ;{ﬁ} Measurement Manager Hl
[t Software Licensing " [# “’?5‘“ *J%LF %

7 Software Licensing g‘il@
E‘!,]Refresh "m“ =] Verify License |

License File: Browse...

B8 HEREBREN

- MREREENEEBERA USB RHETVER » AINFEHITIRE
7 F2RE E'JTE%H‘QEWE'J’FEF_@%%?E@’Eﬁﬁﬁﬁﬁﬁ@\ﬂ@l’fﬁ
HNEmZREIBENEZEH

- NRMAFELEZE Agilent Measurement Manager » BIFE 2K E)
Software Licensing ¥ 11 Z %21\  7£ Agilent Modular Products
Installation Menu 1=3%EY Software Licensing * A& KIBEE EHY
ETErT -

o« % %lfyéﬁ%{ P %E ') Measurement Manager ™ *%= Tools >
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